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About this course
Objectives of the course
Upon completion of this course, you will be able to: 
- Create an interactive view and draw a sketch on it
- Insert annotations to dress-up the views
- Use advanced dimensioning tools
You will also be introduced to the 2D-3D links management and to 
the drafting workbench customization

Targeted audience
Draftsmen 

Prerequisites
Students attending this course should be familiar with the basics 
of 2D views creation in CATIA V5 2 days
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Introduction to Drafting Workbench
You will get familiar with the Generative Drafting Workbench.
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Generative Drafting Presentation

The Drafting workbench allows you to automatically generate engineering drawings 
from CATIA Part and Assembly documents.

Engineering drawings generated using this workbench are associative, i. e. any change in 
the geometry of original Part or Assembly will be reflected in the drawings.
You can generate associative dimensions on these drawings.
You can use company standard templates to generate the drawings, and also you can dress-
up the drawings with annotations consistent with the company standards.



Student Notes:

Detail Drafting
����������	��

Copyright DASSAULT SYSTEMES �

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S
 2

00
2

7

Drafting workbench contains the tools to create views, dimension the views and 
also the interactive tools to create annotations, company templates.

Part Document 
Created using 
Part Design 
workbench

Product Document 
created using

Assembly Design 
workbench

If the part or product changes, the 
drawing will be updated, to take 
into account design changes.

Drafting: General Process

Generate Views

Generative 
Drafting

Dimension

Design Changes

Interactive 
Drafting

Non Associative 
Annotations

DraftingSource Document
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Accessing the Workbench

You can access the Drafting workbench from 1- Start menu  2- File menu 3- Workbench 
icon

1

2

3
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Drafting Toolbars and Objects

1 -

2 -

3 -

4 -

5 -

6 -

7 -

8 -

Each toolbar contains objects related to specific tasks. Icons within these toolbars are 
compressed and can be expanded for accessing additional functionalities.

Dimension 
properties

Text 
properties

Graphic 
properties

1 -

2 -

3 -

4 -

5 -

6 -

7 -

8 -

1

2

3

4

5678
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View Frame

View Name

and

View Scale

Grid

Active view 
(underlined in the tree and with a red 

frame)Specifications Tree

Views

Prompt zone

Drafting Terminology
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Creating Interactive Views
Drawing views use sketcher tools to create 2D views.  Unlike a Generated view, 
these views have no link to a 3D model.

Starting an Interactive Drawing
Drawing the Views
Adding Projection Views
Methods and Recommendations
To Sum Up
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Starting an Interactive Drawing
You will learn how to create front view in Interactive Drafting.
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S To complete a generative view with 
interactive elements.

Why Interactive Drafting

Interactive Drafting is a drafting system that can be used in a standalone 2D CAD 
environment. It can be used for traditional drafting purpose i. e. for creating 2D 
drawings of the components for which you do not have 3D models.

Simple 2D drawings can be created in 
Interactive drafting without a 3D model. These 
drawings can be used to express design ideas.

2D interactive functionalities can be used in an 
advanced production environment for the 
dress-up and annotation of drawings. 

TABLE

NOTES

ANNOTATIONS
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Starting the Front View

When a drawing is created, you need to add a front view before starting to draw 
lines.

Place the view by clicking on the sheet

The Front view is added in the tree and 
on the Sheet with a blue HV reference 
axis and a view frame

Select the New View icon.1 2

3

View frame : By default, a view frame is 
displayed and always fits the content of 
the view and changes with it.
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Drawing the Views
You will create basic sketches within the Drafting workbench
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Sketching in the drafting workbench gives you the ability to create 2D shapes. A sketch is a 
rough drawing by nature however it is possible to create precise elements.  

Sketching ...

When first creating a sketch thought should be 
given to the basic shape of the profile and not 
precise measurements. Once the profile is 
created, constraints can be added to help better 
define the profile.  Finally, by editing the applied 
constraints, the precise profile can be obtained.

A typical approach to sketching is made up of three steps:
Profile Creation
Creating Sketch Constraints
Editing Constraints
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Select the Profile icon

Sketches drawn with the profile icon help to eliminate the need for the creation of 
multiple sketched entities such as line, curve and trim. Profiles do not need to be 
created precisely which speeds up sketching.

(a)

(2)

Select the Tangent Arc icon 

Click to create the 
arc when it is inline 
with the vertical 
axis. 

Click on the origin to close 
the profile. 

Example results :

Profile Creation

1 Enter values for the First Point, 
Length and Angle.

2 Enter values L: 50mm & A: 90deg3

Click to create angle (A) 
and click again to create a 
horizontal line (B). Blue 
indicates horizontal.

(A)
(B)

4

6

5

7
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Point Creation

Type

Points by Clicking

Points by Coordinates

Equidistant Points

Intersection Point

Projection Point

Icon Description

Create a point just clicking where you want it to be.

Create a point defining its coordinates in the 2D 
space of the Sketch.

Create as many points as you want equidistantly 
distributed on an existing curve.

Create the intersection point between two existing 
curves.

Project an existing point onto an existing curve 
normally to this curve.

Point types available in the Drafting Workbench:
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Line Creation

Type

Infinite Line

Bi-tangent 
Line

Bisecting Line

Line Normal 
to Curve

Line

Icon Geometry Description

Create a line by clicking two points to define its 
extremities.

Create an infinite line defining its direction by 
clicking two points.

Create a line tangent to two existing curves.

Create a line bisecting to two existing lines.

Create a line perpendicular to an element.

Line types available in the Drafting Workbench:
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Circle Creation (1/2)

Type Icon Geometry Description

Circle

Three Points 
Circle

Circle by 
Coordinates

Tri-tangent 
Circle

Create a circle defining its center and its 
radius by clicking.

Create a point passing by three points.

Create a circle giving the coordinates of its 
center and its radius.

Create a circle tangent to three existing curves.

Circle and Ellipse types available in the Drafting Workbench:
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Circle Creation (2/2)

Type Icon Geometry Description

Three 
Points Arc

Three points 
arc starting 
with limits

Arc

Ellipse

Create an arc passing by three points, relimited by the 
first and the last selected points.

Create an arc passing by three points, 
relimited by the first and the second selected 
points.

Create an arc defining its center and the two limit points.

Create an ellipse by selecting its center point, 
and defining its dimensions by clicking two 
points.

Circle and Ellipse types available in the Drafting Workbench:
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Curve Creation (1/3)

1 2 3 4 5

2 3 4

Focus and summit selection Relimiting points selection

1

Start with two curves

1 2 3 4

Type Icon Geometry Description

Spline

Connect

Parabola by 
Focus

Create a spline curve 
passing by as many 
points as you want. End 
the spline by double-
clicking.

Create an arc connecting 
two curves.

Create a Parabola selecting:
• The focus point
• The summit
• The relimiting points

Curve types available in the Drafting Workbench:
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Curve Creation (2/3)

4 5
Focus and center selection Summit and relimiting points selection

1 2 3

Type Icon Geometry Description

Hyperbola 
by focus

Hyperbola by focus
• Create an Hyperbola selecting:
• The focus and center points
• The summit
• The relimiting points

Curve types available in the Drafting Workbench:
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Curve Creation (3/3)

.

1

2

3

4

1 2

3

4

1

2

3

4

5

1 2

34
5

5

Conic: Conics can be created in several ways. After the ICON is selected, 
several conic tools appear in the toolbar shown.

Icon Geometry Description

Two point conic 
with end tangents

Two point conic 
with tangent 
intersection

Four point conic 
with one tangent

Five point conic

Select an end point, define its 
tangency, select the other end 
point and its tangency, select a 
mid point

Select two end points, select a 
point which defines the 
tangent intersection, select a 
mid point.

Select the two end points, 
select two mid points, define 
one tangency at first or last 
point.

Select two end points, select 
three mid points.
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Relimitation Elements (1/2)

Type Icon Geometry Description

Corner

Chamfer

Trim

Break

Trims two elements to create a round 
corner. Option available to keep 
existing edges or to trim them.

Creates a beveled corner at the point 
where two selected edges meet.  
Option available to keep existing 
edges or to trim them.

Trims or extends elements to form a 
closed corner.  Select elements on the 
side of the intersection you want to 
keep.

Divides an element at selected point.  
Creates two elements from one.

Relimitation types available in the Drafting Workbench:
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Relimitation Elements (2/2)

Type Icon Geometry Description

Quick Trim

Close

Complement

Trims the selected element to 
the intersection of another 
element.

Connects the endpoints of the 
element to close it.

Replaces the existing element 
with an element that would close 
the original.

Relimitation types available in the Drafting Workbench:
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Transformation Elements (1/2)

Transformation types available in the Drafting Workbench:

Geometry Description

Creates mirror image of 
selected elements 
about a selected line or 
axis

Moves selected 
elements in the X 
and/or Y direction.  
Can also be set to 
duplicate mode.

Moves selected 
elements about a 
selected line or axis

Type

Symmetry

Translate

Mirror

Icon
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Transformation Elements (2/2)

Transformation types available in the Drafting Workbench:

Type Icon Geometry Description

Rotate

Scale

Rotates selected 
elements.  Can also be 
set to duplicate mode.

Enlarges or shrinks 
selected elements 
by a ratio of the 
original.

Offset Offsets just the 
selected element. Can 
also be set to offset all 
elements connected to 
the selected element.
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Creating Sketch Constraints

A sketch can be constrained using geometrical constraints, such as tangency, to 
establish geometrical relationship.

1

(A)

(B)

Select the elements to constrain. 

Select the vertical line 
A and arc B 

2 Select the “Constraint Defined in Dialog Box” icon.
Select the Type of geometrical constraint in 
Constraint Definition dialog box.

Select Tangency.

Or the sketch can be constrained by creating controlling dimensions which can be edited.

(A)

(B)

(C)

(E)

(D)3 Select Dimensions icon and the elements 
to constrain and indicate the location.

(A) Length of lower horizontal line
(B) Distance between horizontal lines 
(C) Radius
(D) Angle of chamfer relative to vertical
(E) Distance of chamfer width relative to right side of 

profile and chamfer point
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Creating Explicit Geometrical Constraints

Explicit Geometric Constraints can be created between sketched elements or between 
sketched and generated geometry.

It is impossible to create a constraint between sketched and generated geometry through the Constraints 
Definition dialog box. Use this method to create a constraint between sketched and generated geometry. 

1 2 Select the elements to Constrain.Select the Geometric Constraint icon.

3

A predetermined Geometric 
Constraint will be displayed. If 
this is the desired constraint, 
select the drawing background 
to confirm.Using the contextual menu, select 

the Geometric Constraint.
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Adding Projection Views
You will create additional projection views on a drawing.
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Added Views are usually created as projections of the Front view. The New View icon             
is used the create projection views one at a time. When an existing view is active, added 
views are created as projections of that view based on 1st or 3rd Angle Projection. 

Any view that is made active becomes the primary view, and added views that are created 
become a projection of this primary view. 

Projection from a Front View is a Bottom 
View based on 1st Angle Projection

Projection from a Bottom View 
Results in a Rear View based on 
1st Angle Projection

What is the General Method to Add Views ?
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Select the new view 
icon

The views added on the drawing are projected from the active view in accordance with 
the selected standard

Place the view by positioning the cursor according to the desired View; for 
example:
- in ISO, above the Front view will give a Bottom view
- in ANSI, above the Front view will give a Top view

ISO

Select on sheet to create the view

Adding Views

1 2

3
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Activate the view in which you want 
to receive the construction lines by 
double-clicking on  its frame or on 
its name in the specification tree

To easily draw the lines in the views, you can use the construction lines. Construction 
lines are projections of the lines of one view into the active view and can be used to 
draw lines. 

Place cursor on the view frame from which you want to get 
the construction lines. Then, using the third mouse button, 
select Show Folding Lines from the contextual menu

Construction Lines

1 2
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Select the Rectangle icon.

When construction geometry is present, Auto Detection recognizes it to anchor 
newly created geometry.

Select the left construction line 
using auto detection to begin 
the rectangle.

Select the right construction line 
using auto detection to complete 
the rectangle.

Select the line icon. Then 
use the intersections of 
the construction line and 
the  rectangle to complete 
the line.

1 2

3

Create Geometry using Construction Lines

4
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Creating a Multiple View Projection (1/2)

1 2
Select the Multiple View 
Projection icon.

Activate the view where you want the 
projection to appear.

This function allows you to generate geometry in a view by projecting geometry from 
previously defined views. The projected geometry retains the same attributes it had in 
the original multi-view.
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Creating a Multiple View Projection (2/2)

Select object defining target 
plane or surface

Select one by one the geometry elements 
(four) which compose the feature (elongated 
hole). The result appears automatically

Two lines and 
two arcs

The result

3 4
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Methods and Recommendations
You will see some suggestions and techniques you can use while creating 
interactive views. Also, you will learn how to complete the generated drawing 
using interactive elements.
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There are several sketching aids available in menu Tools >Options > Drafting in the 
General and Geometry tabs.

Sketching Aids (1/2)

Using these aids will minimize the need to Edit 
Constraints to make the sketch precise.
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Make use of construction lines and transformation tools to increase your efficiency.

Sketching Aids (2/2)

Use construction lines to ensure projection 
views are in line with the main view.

Take advantage of the transformation tools 
available to help increase your efficiency while 
constructing similar or identical geometry.

RotateMirror

Construction lines.

Create the approximate profile first and then 
use constraints to make the sketch more 
precise.

Initial Sketch Final Sketch
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Completing a Generative View

2D interactive functionalities can be used in an advanced production environment for 
the dress-up and annotation of drawings. 

TABLE

NOTES

ANNOTATIONS
Annotations can be used to 
define geometrical tolerances

Precise positions of key points 
can be given in Table Format.

Information related to manufacturing 
can be added in the form of notes view.

ABSOLUTE POSITIONING LINES
In case of larger assemblies 
absolute positioning can be 
drawn on the drawing.
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How to create interactive views.
How to use sketcher tools to create geometry.
Remember, a typical approach to sketching consists of three steps: 

Creating Profiles
Creating sketch constraints
Editing constraints

To Sum Up

You have learned:
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Dressing Up the Layout
To fully detail a drawing it is often necessary to add additional information such 
as geometric tolerancing, notes, or tables. In this lesson we will look at how to 
create these.

Adding Annotations and Text
Creating Tables
Graphic Dress-up
Instantiating Elements From a Catalog
Methods and Recommendations
To Sum Up
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Adding Annotations and Text
You will learn how to add symbols geometrical tolerances and text to the drawing.
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Symbols

You can add symbols to better define the specifications of the part.

Geometry Description

Creates a standard roughness symbol 
including roughness value, direction of lay, 
production method etc.

Creates a weld symbol including 
complimentary symbols and weld finish 
symbols.

Creates a geometry weld symbol 
between two elements.

Type

Weld

Welding 
Symbol

Roughness
Symbol

Icon
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Geometrical Tolerances

You can add symbols to better define the specifications of the part

Geometry Description

Creates standard geometrical tolerances 
including symbols and references.

Annotates a Datum Feature.

Annotates a datum target.

Type

Datum Target

Datum Feature

Geometrical 
Tolerance

Icon
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Creating Text

Text can be created with or without 
leaders and can have many 
properties to customize the font and 
frame style (shown on the right).

Special symbols can also be inserted 
into the Text as needed. 
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4

Key the desired text with the appropriate framing 
or embedded symbols; for example:
(a) Key “HOLE” then spacebar
(b) Select           from the Symbol icon then press 

spacebar
(c) Key “SIZE 3” then press ENTER to start new 
line
(d) Key “SEE NOTE” then press spacebar
(e) Select             from the Frame icon

(f) Key “1”.

Select the Text icon
to create text without a leader

Text without leaders with a customize symbol and frame style.

Select the text anchor 
(starting) point

Example results:
Select anywhere to end the text.

Text without Leader

1 2

3



Student Notes:

Detail Drafting
����������	��

Copyright DASSAULT SYSTEMES �	

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Select the Text with Leader icon

Here is how to create text with leaders:

Select the text anchor 
point

Key desired text 
(ITEM 4)

Select an anchor point for the 
arrow head

Click anywhere to end the leader text

Text with Leader

1

3

4

5

2

Example results:
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Select the Balloon icon

Select location for the balloon

Key desired text (2)

Select an anchor point for the arrow head

Non-Associative Balloons

1

3

4

2

Example results:
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Editing Text

Text can be modified to change leader style the content, style or the orientation of 
the text.

Change arrow 
style

Change text 
orientation

Add breakpoints 
and create 
multiple leaders

Change Text font or justification
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6

5

1

Text can be manipulated in the following ways: Edited, Repositioned and/or Leaders 
added or removed

Swipe the cursor across the text (second 
line) within the Text Editor window and edit 
or delete.

Right click on the anchor point of 
the leader arrow, select the option 
from the contextual menu

To add a leader; Right click the note and select:

Select any part of a note and drag to 
reposition it

Indicate or select an element to anchor the 
arrow head.

Select the anchor point of a leader 
arrow and drag it to reposition it

This process can be repeated 
to create multiple leaders.

Text Manipulation

2

3

4

Double click text to open the Text Editor.
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2b

1bRight click on the note and select 
Properties from the contextual menu.

Text font and justification can be modified through the properties dialog box or the 
Text Properties toolbar.

Click OK to 
complete the 
change.

Make necessary changes.

Use the Text Properties toolbar 
to make changes.

Highlight the note.

Text Properties

1a

3

2a
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Text with Breakpoints and Multiple Leaders

Select the Text with 
Leader

Here is how to create text with multiple leaders and breakpoints.

Using the contextual menu, 
select a breakpoint and the 
Add an Extremity item.

Using the contextual menu, Select the 
anchor point (yellow symbol) and Add a 
Breakpoint item.

Select an element or location to 
end the leader Example result:

Add Breakpoint:

Add Leader:

Select the breakpoint and 
drag to desired location

21
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Define a link to 2D geometry to determine the orientation of text

Right click on the text1 Select option Orientation Link 
and Create

2

Select orientation element3

Associated Text 

As the element rotates, the text will     
flip to avoid being backwards or upside  
down unless the text property Auto Flip 
is disabled
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Creating Tables
You will add a Table to a drawing and modify it
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Tables are used to capture drawing information in tabular form. Typically tables 
are used to handle title block information or bill of materials.

Tables can be created each time or they can be created in another program saved 
as a CSV file and imported into one or  many drawings.

Tables
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Creating a Table

Select the key Table icon1

To create a Table of data for Bill of Material list, Revision Notes, or etc...

Key the number of columns 
and rows for the Table

3

Select the Table location2

Double click the Table to select it.4 Double click a Table cell to edit it.5

Continue step 5 to fill in all 
necessary cells.
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Creating a Table from a csv file

Select the key Table icon1

To create a Table of data from a csv file for Bill of Material list, Revision Notes, or etc...

Select a location for the Table3

Select the csv file2

A CSV file is a text file that is comma delimited.  
To create a CSV file: save the file created in 
another program as a .csv file.



Student Notes:

Detail Drafting
����������	��

Copyright DASSAULT SYSTEMES �


C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Editing a Table

Double click the Table to select 
it

1

To edit a Table element to add or delete rows and columns, resize the rows or 
columns, and invert the rows or columns.

Double click a Table cell to edit , Use the contextual 
menu to select the item to modify or select a 
row/column marker to resize.

2
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Right click on the table and select Split 
Table from the contextual menu

A table can be split if it becomes larger than a given number of rows

Select the OK button to 
complete

Enter in the Split 
Criteria

Splitting Tables

1

3

2

Example 
results:

Enter number of 
rows the table 
can have before 
it splits or the 
maximum height 
before the split

Enter distance 
between the split 
tables

Tick box if the 
first row of the 
original table is 
to be copied to 
the split tables
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Graphic Dress-up
You will learn how to apply dress-up such as centerlines threaded representation and 
patterns to a drawing.
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Select the Center Line icon

Centerlines for various applications are available in the Insert >Dress-up > Axis and 
Threads menu. Centerlines can be resized after the creation. 

Select the circle

Select the Axis Line icon

Select two reference lines to
fit the axis line between.

Center Lines

1

2

1

2
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Select the Area Fill icon

To draw a section cut, you need to add a sectioning symbol to represent the material. 
You can choose between several types of symbols in a Pattern Table.

Select automatic Area 
detection.   

Select in the zone to fill

Adding a Pattern on a Section

1

3

2

The”With Profile Selection” option allows you 
to manually define the area to be filled
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Select the hatching 
pattern to modify. Select 
the properties using the 
right mouse button.

1

Modify the current patterns attributes or 
select a new type of pattern from the type 
pull-down

2

Changing  Hatching Pattern (1/2)

Click the button 
to browse to 
access the 
Pattern Chooser 
dialog box.  
(Discussed on 
the next Foil)

Note the different types 
of Patterns that can be 
selected from the pull-
down

3
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Select the          to open the 
pattern Chooser. 

3

Choose the Pattern type 
and Select OK  to return to 
the Properties window.

4

Changing Hatching Pattern (2/2)

Change the attributes of the 
new pattern type if 
necessary and select the 
OK button to update the 
pattern

5

The pattern is changed 
on the section.
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Instantiating Elements From a Catalog
You will learn how to instantiate a 2D elements from a catalog and how to synchronize 
links between CATDrawing and the catalog file.
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Why Instantiate a Component From a Catalog

Link is maintained between the Instances and the original 2D component. You can update 
the instances to reflect the changes made in original 2D component. 

A 2D component is a re-usable set of geometry and annotations. This component is stored
in a CATDrawing referred by the catalog. The 2D component can be instantiated several 
times, each instance providing a component with a specific orientation, position and 
scale.

2D component 
stored in a 
CATDrawing

Instances of 2D component.
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How to Instantiate a 2D Component From a Catalog (1/2)

You can multi-instantiate a 2D component from catalog, reorient the component and 
explode them at the time of instantiating.

1 Activate the view in which you want 
to instantiate the 2D component and 
select Catalog Browser icon.

2 Open the source catalog file, using 
Browse another catalog tool.

Catalog Browser 
dialog box gives you 
list of the chapters in 
the catalog file. 

3 Double click on the chapter in which 
required 2D component is placed.

4 Select the 2D component you 
want to instantiate.

Preview of the 
component will be 
displayed. 
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How to Instantiate a 2D Component From a Catalog (2/2)

5 Drag the component from Catalog 
Browser into the drawing window, and 
select the points where you want to 
instantiate.

6 Set the Angle and Scale values

7 Click on the empty space in the sheet 
to exit the command. 
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How to Synchronize the Links

When a original 2D component is modified, you need to synchronize the link between 
the 2D component and the instance to reflect the changes made in original 2D 
component. 

3 Select OK inside the Links dialog 
box.

2 In the Links dialog box select the MML link 
between the 2D Component and the 
instance, select Synchronize.

1 Select Edit > Links.

The instance is modified as per 
the changes in the original 2D 
component.
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Methods and Recommendations
You will learn about notes view, attribute links and links of a 2D component 
instance.
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Using a Notes View for Text and Table

A note view is used to add the notes in the drawing. A Note View is a stand alone view 
that is not projected from an existing View. Create a front view and rename it to “Notes 
View” and then add notes to this view.
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To create an attribute link in a note or table cell use the same technique

Double click on the text you 
want to add the link to

1 Right click and select Attribute 
Link from the contextual menu 

2

Example results:5

Select the object you want 
the text to link to

3

Select the attribute from the list and 
click the OK button to complete

4

Adding an Attribute Link

An attribute link will update when changes are made in the parameter it is linked to, provided the Automatic 
Update mode is turned on in the Options > Mechanical Design > Part Design > General Tab 
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Links to the Catalog

When a 2D component is instantiated from a catalog a link is created between the  2D 
component instance and the CATDrawing file which is used to create the catalog.

2D component stored 
in a CATDrawing

Instances of 2D component.

Link

Catalog

You can break the link between the original 2D component and 
the instance, using Explode 2D component command available in 
contextual menu.
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Add symbols to a drawing
Select the appropriate symbol from the Symbol toolbar 
Add Tolerance
Use the Dimension Properties toolbar for quick access to tolerance
Create GD&T symbols
Use the Tolerancing Toolbar
Create text
Use the Annotation toolbar
Create a table

To Sum Up

You have learned how to:
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View and Sheet Management
It is sometimes necessary to modify sheets and views properties to improve 
layout to better suit the needs of a particular drawing.

Sheets Management
Views Management
To Sum Up
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Sheets Management
You will learn how to add a new sheet to a drawing, and how to change the 
properties of a sheet.
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Sheets are added to a drawing to improve clarity and manage views or annotations 
that are cluttering a single sheet drawing. 

Sheet 1 of 2 Sheet 2 of 2

Why Add Sheets to a Drawing?
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Select the New Sheet icon
It creates an empty sheet with the next sheet number (Sheet 2)

Adding a Sheet to a Drawing

1

The new sheet is assigned the same standard, format and orientation as the first 
created sheet
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There are times when one or more sheets in a drawing may require properties 
that are different from the rest of the drawing sheets.  By accessing Sheet 
Properties you can customize individual sheets.

Why Change Sheet Properties?
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2

1
Select the Sheet in the tree and Properties in the 
contextual menu to change its properties.

Modify the sheet name, the scale, 
the format (ANSI or ISO) or the 
projection method (first angle or 
third angle).

Sheet Properties
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Views Management
You will learn how to reposition views on a single sheet and how to move views 
from one sheet to another sheet.
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00
2

84

A view can be positioned at an exact position on a Sheet and relatively to another view 
already on the sheet.

Here view B is positioned relatively to view A

Relative Positioning

Positioning stick showing distance

Geometric center of view

Middle top anchor point

View A

View B

This is often used for isometric views, and particularly for exploded views of assemblies
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Select « View Positioning » then « Set 
Relative Position » in the contextual menu

Repositioning a View with Relative Positioning  (1/3)

A positioning stick appears with anchor points around the 
view and in its center

Anchors points

Positioning Stick

The stick has 3 handles: 
- the green end
- the stick
- the black end

By default, the green handle 
is on the center anchor point 
and the stick is oriented SW 
(south-west).

Remember the contextual menu can be 
accessed from the tree structure or the view 
frame. Therefore, the view frame does not need 
to be on to use the relative positioning option. 

1
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Repositioning a View with Relative Positioning (2/3)

Stick length and distances values appear. Drag 
along the stick to make it shorter or longer: the 
view moves accordingly.

There are 4 ways to move a view with the positioning stick
You need to combine these to position the view

The black end snaps on the center of the 
selected view frame and the view follows 

(A) Selecting the Stick

2

(B)  Selecting the black end and another view frame
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Repositioning a View with Relative Positioning (3/3)

(C) Selecting the green handle

The green end moves to the selected anchor point and 
the view is moved 
(ex. here bottom middle anchor was selected; view 
moved up)

(D )  Selecting another anchor point

Drag to rotate the view around the black end 
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Cut the view on the sheet to be moved.

Moving Views from one Sheet to Another Sheet

Paste the cut view on the desired sheet 
in the specification tree.

Contextual Menu

A view can be moved from one sheet in a drawing to another.  This can be useful 
when a sheet becomes too cluttered.

1 2

Sheet 1 Sheet 2
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Reordering Views in the Specification Tree

You can organize your specification tree by using reorder command. The children 
views can be arranged after the parent view.

1 Select the views you want to 
reorder and launch reorder 
command from contextual menu.

2 Select the view after 
which you want to place 
the reordered views.  

Section view A-A, Detail D 
and Section view B-B 
reordered after the front view  

In the same way, you can reorder the sheets also.   
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Modifying Graphical Definition for Views

According to your or your customer’s needs, CATIA allows you to modify the 
graphical attributes of Section, Detail or Auxiliary views. 

1
Select the view callout and select 
Properties with the contextual menu. 2

Select the Callout tab. Use the different 
commands to customize the drawing.

Switches for predefined types of lines

Customize the  
arrows

Preview

Customize the line, the extremities 
and the anchor point

3
Select Ok.
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How to Restore the Graphical Definition?

You can restore the deleted graphical definitions of section views, auxiliary views 
and detail views.

1 Right click on the section 
view and select Section view 
XX object > Add Callout 

2 Select the parent view

Graphical representation of the section 
view restored in its parent view.
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To Sum Up

In this lesson you have learned:

How to add additional sheets.
How to modify sheet properties.
How to edit the properties of a sheet.
How to reposition the views.
How to move a view from one sheet to another.
How to modify graphical definition for views.
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Customizing the Drafting Workbench
In this lesson we will look at options available to you to customize the Drafting 
workbench. 

Drawing Customization Options
Setting Drafting options
Standard Management
To Sum Up
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The options shown in this course are just some of the numerous options available to 
customize the Drafting workbench.

The options that will not be discussed in this course are typically controlled by an
administrator and not a user.

Drawing Customization Options
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Setting Drafting Options
You will learn how to set the session’s default drafting options
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What are Drafting Options? (1/2)

1. General - Determine display of ruler, grid, background colors and tree display

2. Layout - Determine display of view name, scale, frame and determines new sheet 
parameters settings

3. View – Determines the display of geometry and view generation

4. Generation - Determines dimension and geometry generation

5. Geometry - Aids to create geometry such as display of center points, auto-
detection for orientation, and constraint creation and display

6. Dimension - Position, Line-up dimensions and Analysis display mode

7. Manipulators – Turns on / Off the manipulators for dimension creation or 
modification 

2 3 4 5 6 71

There are primarily nine Drafting Option tabs that allow the user to customize the 
drafting interface.
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What are Drafting Options? (2/2)

8. Annotation and Dress-Up – Turns on/off the controls for annotations

9. Administration – Controls for administrator

8 9
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3

Snap to Point and grid display can also 
be controlled from the toolbars. 

General Options (1/2)

Set the following General options:

1

2

2
3

1 Show Ruler: In the OFF position the 
ruler along the top and left side of 
the screen will not be displayed.

Grid: With the Display turned ON and 
Snap to point turned ON. Adjust the 
Primary spacing and graduations to aid 
in dimension placement.

Allow distortions: Allow you to 
change the scale of H and V on 
the grid.
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Set the following Display options:

General Options (2/2)

Colors: Change colors of the 
sheet and detail background.

Tree :Display parameters and 
relations in the specification 
tree.

View Axis: Provides a blue 
axis in the view that is current.

1

2

3

3

2

1

4 Start Workbench: ‘New’ dialog 
box when starting the drafting 
workbench.
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Layout Options

1) View name: Check that it is OFF since primary and projected view  names are not normally necessary.

2) Scaling factor: Check that it is OFF since primary and projected view scale will be declared on the drawing
as a global scale for the drawing.

3) View frame: Turn on to easily understand which view is active and to quickly access view properties.

4) Propagation of broken and breakout specifications: Allows the propagation a Broken or Break-out 
specification during the creation of a projection or auxiliary view.

5) Auxiliary and/or section views orientation according to profile: Allow the view axis to be orientation
according to profile6) New Sheet : Allows the selection to determine where the sheet properties will be 
copied from and an option to copy the background view.

1

2
3

5

4

6

Set the following view Layout options:
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Set the following view Generation options:

Dimension Generation: Allows dimensions to be automatically positioned after generation,automatic 
transfer between views and analysis of dimensions that have been generated

Time delay between dimension generation when using the step by step method can also be set 
prior to starting the generation process.

Generation Options
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Set the following view Geometry options:

1) Geometry: Interactive geometry creates circle 
and ellipse centers and end points  included 
with drag elements 

2) Smart Pick: Provides an aid for creating 
geometry relative to existing features and 
geometry

3) Constraint Display: Allows what constraints 
will be visualized and the constraints color and 
size

4) Colors: Allows you to visualize and choose 
colors for geometry elements

Geometry Options

1

2

3

4
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1.Manual positioning at creation: 
allows full freedom for dimension 
positioning.

2.Associativity on 3D : a link can be 
applied between a dimension and 
the 3D part. As a result, when you 
update the drawing, the dimension 
is automatically re-computed. If you 
do not check this option, when you 
perform the update, you need to re-
create the dimension afterwards.

3.Line-Up default: a default spacing 
between dimensions when a Line-
Up and a reference dimension are 
selected

4.Activate analysis display mode: 
Displays dimension status of Non 
up-to-date dimensions, Non 
associative dimensions, converted 
dimensions, Fake dimensions, 
Driving dimensions and True 
dimensions

Before creating any dimensions, turn on the following Dimension options:

Dimension Options

1

2

4

3
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Manipulators Options

Option to enable dimension manipulators to control the precise location or properties during 
creation or modification of dimensions

1

2

3

4

5

6

7

1

2

3 4

5 6 7

1a

3a

4a
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Annotation Options

Options to enable SNAPPING to control the precise location or properties of 
text, leader text, or GDT during creation or modification

Annotation Options for Text, Leader Text, and GD&T
1. Settings to choose the leader default behavior
2. Stay Horizontal/Vertical with leader creation
3. Free orientation

Ability to Swap the text or GDT orientation during creation
1. With the Ctrl key, swap from vertical to horizontal
2. With the Shift key, free or lock perpendicular the leader
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Standard Management.
You will learn about customizing the drafting standards.
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Why Standards?

These standards govern the different parameters of the drawing elements such as Angle of 
Projection of the views, dimension style, line types and many more.

Administrator can create company specific standard files and 
draftsmen will use these standards while creating new drawings.

Dimension in ANSI standard. Dimension in ISO standard.

Drafting standards are used to have uniformity in the drawings created. All Draftsmen 
referring to the same standards, ensures the uniformity in the graphic conventions 
drawings. Administrator can set the standards complying to the specific organization.

To maintain integrity of the standards only administrator can 
change the standards. Following slides will tell how Administrator 
can change the standards.
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Accessing the Standards

Standards are stored in a xml file. Administrator can edit these files using an 
interactive editor.

1 Select Tools > Standards 
menu.

2 Select drafting Category and select 
the respective standard file.

This editor provides an easy-to-use graphic 
interface to customize the parameters 
included in the standard files.

Save the changes made in the standards in a new xml file.  To modify the 
standards you need to start the CATIA in Administration mode.  
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Standards Content

Standard file contains several main sections, each dealing with a specific aspect 
of drafting customization. Following are few important sections.

Styles: Administrators can set the default values that will be applied
to all properties of the elements such as sheets, geometry, 
annotations, dimensions, dress-up and dress-up symbols etc.

General: Administrator can control and restrict the values that are 
available for some element properties e.g. Text fonts used by 
draftsmen can be controlled using this property. 

Dress-Up: Administrator can control the appearance of Dress-Up 
parameters such as threads and markup arrows.

Dimensions: Using this node administrator can control the 
appearance of Dimensions e. g. appearance dimension value.

Tolerance Format: The tolerance format parameters drive the 
representation of a dimension tolerance, and include parameters such 
as type of tolerance, font size for tolerance etc.

View Generation: This node lets administrator customize settings that 
should be applied when generating views in a Generative Drafting
context.

Frames: Frames around text and annotations can be customized 
using this node.

Line Types: Line types applied to the elements in a drawing, such as 
lines, curves, dimension lines etc. can be customized using this node.
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Taking Into Account Standard Modification

When draftsmen create a CATDrawing document they specify the standard that will be 
associated with this document. The values of the parameters in the specified standard 
file are then copied into the CATDrawing document. 

When Administrator modifies a standard file, 
updated standards will be applied to the new 
drawings created afterwards.

To take in account these modifications in 
previously created files, you have to open them 
and reapply new standard using File > Page 
Setup command.
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To Sum Up

You have learned:

How to customize the CATIA Drafting workbench
Options to customize the drafting workbench.
How standards are used to bring in uniformity in the drawings
How to modify the standards


